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1. Introduction 

A la fin du cursus de Bachelor de la filière Informatique de gestion auprès de la HES-SO 

Valais-Wallis, les étudiants développent un projet de fin d’études. Dans mon cas, ce travail a 

été réalisé sous la surveillance du Prof. Dr. Werner Maier et l’assistance de Monsieur Frédéric 

Morand.  

Dans un premier temps, SAP CDS a été étudié sous un angle théorique afin de mettre en 

avant l’ensemble de ses fonctionnalités. L’étude rapporte notamment sur le concept de cette 

infrastructure unique, sur les différences entre ABAP CDS et HANA CDS, ainsi que sur les 

avantages de SAP CDS par rapport à l’ABAP Dictionary. Dans un deuxième temps, une fois 

l’approche théorique achevée, deux prototypes ont été développés afin d’illustrer de manière 

pratique les concepts étudiés. 

Ce travail a débuté le 2 mai 2015 et s’est terminé le 31 juillet 2017. Les deux premiers mois 

d’écriture de ce travail se sont déroulés en parallèle avec les cours du cursus académique, 

puis, jusqu’à la fin juillet 2017, l’écriture du travail a été réalisée de manière exclusive. Ce 

travail était mon premier choix et m’a permis d’élargir mes connaissances dans le domaine 

SAP, domaine que je privilégie particulièrement pour mon avenir professionnel. Il m’a 

également permis de mettre en œuvre la méthodologie Agile apprise durant le cursus 

académique. Cette méthodologie a été adaptée dans le cadre du projet. 
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2. Technologies 

Les technologies importantes abordées tout au long de ce rapport sont détaillées dans cette 

partie.  

 SAP HANA Platform 

La plate-forme informatique SAP HANA (High Performance Analytics Appliance), dite In-

Memory, prend en charge différentes applications pour les regrouper dans un système et 

permet de réimaginer les processus métier afin de fournir des informations en temps réel sur 

la base de données toujours à jour utilisée pour la Business Intelligence. En effectuant 

l’analyse des données en temps réel, elle permet de réduire les redondances, le matériel et 

les opérations informatiques (Karamba, 2017). Elle est l’une des premières plates-formes de 

gestion de données à gérer le traitement des transactions (OLTP pour OnLine transaction 

processing) et les analyses en mémoire (OLAP pour OnLine Analytical Processing) sur une 

seule copie de données. SAP HANA offre également la possibilité de développer des 

applications, d’intégrer des données et d’assurer leur bonne qualité. Elle permet ainsi de gérer 

un gros volume de données structurées ou non structurées. La plate-forme offre également la 

possibilité de déployer les données sur un site web ou le cloud (SAP, 2017). 

Comme illustré par l’image ci-dessous, la plate-forme SAP HANA regroupe toutes les 

données venant de différentes applications dans une seule copie de données (Technology, 

2017). 

 

Figure 1: Plate-forme SAP HANA1 

                                                      
 
1 Source : https://www.sap.com/documents/2016/02/bedb9729-5f7c-0010-82c7-eda71af511fa.html 
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 SAP HANA  

SAP HANA correspond à la base de données relationnelle (SGBDR) en mémoire de SAP 

HANA Platform qui regroupe le traitement OLAP et OLTP sur une même base de données 

(SAP, 2017). Elle permet d’exécuter les analyses en même temps que les transactions sur des 

données à jour et ce, rapidement (Bizien, 2017). Elle possède les propriétés ACID, soit 

(Christophe, 2017) : 

 Atomicité : une opération se fait soit en entier, soit n’est pas exécutée ; 

 Cohérence : les données doivent être cohérentes ; 

 Isolation : les opérations sont indépendantes les unes des autres ; 

 Durabilité : les modifications sont enregistrées même en cas de problèmes tels 

qu’une coupure d’électricité. 

Construite en colonnes dans la mémoire, elle optimise le traitement multidimensionnel. 

Avec les différents outils de modélisation et la bibliothèque de fonctions, elle offre une 

exécution directement sur la base de données, évitant ainsi des latences dues au déplacement 

de données entre une base de données et un serveur d’application. Il faut noter que les 

différentes bases de données condensées d’une seule et unique base gardent tout de même 

un isolement l’une de l’autre. Les tables, construites sur plusieurs étages, permettent de 

conserver en mémoire les données déjà consultées (Bizien, 2017). 

 

Figure 2 : Données en ligne / Données en colonnes2 

 
 
  

                                                      
 
2 Source : http://pdvsap.blogspot.ch/2014/06/quest-ce-que-hana.html 
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 S/4HANA 

S/4HANA est la nouvelle ERP de SAP, soit la quatrième version de SAP Business Suite, 

construite sur la plate-forme SAP HANA et fonctionnant uniquement avec la base de données 

HANA (SAP, 2017). Elle regroupe la suite SAP Business Suite en un seul produit dit en 

mémoire (Illumiti, 2017). Elle est conçue de manière plus simple, avec de nouvelles 

fonctionnalités. Elle est également plus rapide et offre une meilleure disponibilité pour le 

déploiement (site, cloud ou hybride). Son design est basé sur l’expérience utilisateur de SAP 

Fiori, laquelle est basée sur SAPUI5 (SAP User Interface for HTML5). S/4HANA permet par 

exemple de prédire ce que les clients seront susceptibles de vouloir afin d’améliorer les 

prévisions (Rousse, 2017). 

Les principales simplifications et les nouvelles innovations offertes par S/4HANA sont : 

 Les modèles de données ; 

 L’expérience utilisateur ; 

 La prise de décision ; 

 Les processus métier ; 

 L’Internet of Things ; 

 Le Big Data ; 

 Les réseaux d’entreprise. 

 

Figure 3: SAP vs SAP S4/HANA3  

                                                      
 
3 Source : https://fr.slideshare.net/DebajitBanerjee/an-overview-of-sap-s4hana-64499419 
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 ABAP Dictionary 

ABAP (Advanced Business Application Programming), se traduisant par programmation 

avancée des applications métier, est un langage de programmation développé par SAP. ABAP 

Dictionary contient la définition de tous les objets SAP se trouvant dans l’entrepôt de données 

(repository). Ce dernier contient l’intégralité du code source et des objets de développement 

enregistrés dans la base de données. Ces données sont indépendantes du mandant et 

subdivisées en fonction des composantes applicatives (ABAP Dictionary, communication 

personnelle, support de cours SAP). 

 

Figure 4 : Repository SAP4 

Le dictionnaire ABAP permet de centraliser tous les éléments se trouvant dans la base de 

données SAP et favorise une utilisation dans le système sans redondances. Tous les éléments 

créés, modifiés ou supprimés sont automatiquement mis à jour dans la base de données. 

Ceux-ci peuvent être des tables, des vues, des traductions ou de la documentation. Ainsi, 

l’intégrité des données, leur cohérence et la sécurité sont assurées (ABAP Dictionary, 

communication personnelle, support de cours SAP).  

Le dictionnaire ABAP est intégré dans l’ABAP Workbench. Le système SAP fonctionnant 

de manière interprétative, il permet au dictionnaire ABAP d'être intégré dans l'environnement 

de développement. Les interprètes ne perçoivent pas les objets originaux mais des 

représentations internes de ces derniers. Lorsqu’une modification est effectuée dans le 

dictionnaire ABAP, le système met à jour ces représentations internes (SAP, ABAP Dictionary, 

2017). 

 

 

                                                      
 
4 Source : Support du cours SAP « 0106_ABAP_Transport_v5.pdf»  
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 Open SQL 

L'Open SQL est un ensemble d'instructions permettant d'interroger la base de données. Il 

est l'équivalent du SQL, simplifié et basé sur une syntaxe et une sémantique uniformes pour 

tous les systèmes de base de données pris en charge par SAP. Ainsi, les programmes ABAP 

utilisant ces instructions seront compatibles avec n’importe quel système SAP, 

indépendamment du système de base de données utilisé (Guru99, Open SQL & Native SQL 

in SAP ABAP, 2017). Les instructions permettent d’accéder aux tables de base de données 

déclarées dans le dictionnaire ABAP. 

Comme le démontre l’image ci-dessous, avec son évolution, l’Open SQL se rapproche du 

SQL standard. 

 

Figure 5 : Evolution Open SQL5 

 OData 

L’OData, pour Open Data Protocol, comme l’indique son nom, est un protocole. Celui-ci 

permet de partager, de créer et de consommer des données venant de différentes sources à 

travers le web. Ce protocole étant basé sur les technologies HTTP, Atom et JSON, différents 

services et applications peuvent consommer les données mises à disposition à travers une 

URI (Uniform Resource Identifier) (Casabianca, 2017). 

  

                                                      
 
5 Source : https://blogs.sap.com/wp-content/uploads/2015/10/a4h_05_enhancedopensql_814086.png 
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3. SAP CDS 

SAP CDS correspond à la nouvelle génération pour la définition des donnés, conçu pour 

les applications centrées sur la base de données. Le Core Data Services est une couche 

d’abstraction multiplateforme, qui peut être comparée à l’OData pour l’interface utilisateur 

(TECHED, 2017). 

Intégré à la gestion du cycle de vie de la plate-forme SAP et basé sur le SQL natif, SAP 

CDS offre une plus grande productivité à travers un maximum de transparence pour 

fonctionner avec différents modèles de programmation (SAP, SAP netweaver application 

server for ABAP 7.5, 2017).  

 

Figure 6 : Core Data Services6 

 Concept 

Techniquement, il s’agit d’une amélioration de SQL permettant de fournir un langage dédié 

(DSL, Domain Specific Langage), et ce, afin de définir des tables et des vues de base de 

données sémantiquement riches, correspondant aux entités CDS (Bisht, 2017).  

Le CDS est donc composé des langages suivants (TECHED, 2017) :  

 Data Definition Language (DDL), pour la modélisation et l’extraction des données. 

Il est basé sur le SQL natif mais avec une productivité plus élevée ; 

 Query Language (QL), pour la lecture des données en utilisant les entités CDS à 

travers Open SQL dans l’ABAP ; 

 Data Control Language (DCL), pour la gestion des autorisations. 

                                                      
 
6 Source : https://assets.cdn.sap.com/sapcom/docs/2016/02/bedb9729-5f7c-0010-82c7-eda71af511fa.pdf 

LENOVO
Stamp
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Comme pour le DDIC (Data Dictionary = ABAP Dictionary), les modèles de données fondés 

sur le CDS sont utilisés pour interagir avec la base de données. Les artefacts CDS sont 

stockés dans le DDIC et sont accessibles depuis un programme ABAP de la même manière 

que pour les tables et les vues ordinaires (Ahmed, 2017). 

Conçu à la base pour le développement d’applications sur SAP HANA, il a ensuite été 

intégré à l’ABAP (se référer au point suivant pour connaître les prérequis minimaux pour 

l’utilisation du CDS) (Kessler, 2017).  

Comme démontré par l’image ci-dessous, le CDS propose une amélioration ou de 

nouvelles fonctions et expressions mises en avant à travers un texte en gras (SAP, SAP 

netweaver application server for ABAP 7.5, 2017). 

 

Figure 7 : Expressions et fonctions CDS7 

En plus de ces nouveautés ou améliorations, les deux nouvelles fonctionnalités majeures 

proposées sont les annotations et la gestion des autorisations, qui seront expliquées au 

chapitre quatre.  

 Prérequis 

Même si SAP CDS était initialement conçu pour SAP HANA, il reste toutefois disponible à 

partir des plates-formes SAP suivantes (TECHED, 2017) : 

 SAP NetWeaver 7.4 SP05 (Support Package Stack 05); 

 SAP HANA SPS6 (Service Pack Stack); 

 SAP Business Suite EHP7, suite on HANA (Enhancement Packages) ; 

 S/4 HANA ; 

 SAP Business Warehouse 7.3. 

                                                      
 
7 Source : https://www.sap.com/documents/2016/02/782ac129-5f7c-0010-82c7-eda71af511fa.html 
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 ABAP CDS 

L’ABAP CDS permet, à travers un framework, la définition et l’utilisation de modèles de 

données directement sur la base de données. Ces modèles, basés sur le langage de définition 

des données et le langage de contrôle de données, se nomment des entités (SAP, SAP - ABAP 

CDS Development User Guide, 2017). 

Il existe deux types d’entités ABAP CDS :  

 Les vues : comme les données d’une application se trouvent sur différentes tables 

de la base de données, les vues CDS permettent de réorganiser les champs de 

tables selon les différents besoins. Une vue CDS peut être définie pour des tables 

ou des vues déjà existantes dans la base de données, mais également pour d’autres 

vues CDS déjà créées. Lorsqu’une vue est activée, une entité CDS et une vue SQL 

sont créées dans le dictionnaire ABAP (SAP, SAP - ABAP CDS Development User 

Guide, 2017) ; 

 Les fonctions de tables : elles correspondent aux fonctions de tables existantes 

sur la base de données et peuvent être utilisées dans le CDS (SAP, SAP - ABAP 

CDS Development User Guide, 2017). 

 HANA CDS 

SAP a introduit le CDS avec SAP HANA dans le but de définir et de consommer les données 

directement sur la base de données plutôt que sur le serveur. A la base, le CDS n’était 

disponible que sur SAP HANA SPS06, puis a été intégré à partir de SAP NetWeaver 7.4 SP05 

(Kessler, 2017). C’est pourquoi les spécifications sont pratiquement identiques à celles de 

l’ABAP CDS à la différence que les sources DDL de HANA ne sont pas utilisables telles quelles 

avec ABAP CDS ni réciproquement (Keller, CDS – One Concept, Two Flavors, 2017).  

Avec SAP HANA, le CDS offre la possibilité « de définir les artefacts qui composent le 

modèle de persistance des données » (Portal, 2017). A travers la création d’un document CDS, 

le DDL permet de définir les artefacts et les éléments suivants (Portal, 2017) : 

 Des entités (tables) ; 

 Des vues ; 

 Des types de données définis par l’utilisateur ; 

 Des contextes ; 

 Des associations ; 

 Des annotations. 
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Les documents CDS possèdent le format .hdbdd et peuvent être considérés comme une 

alternative aux .hdbtable et .hdbstrucure (Jung, 2017). 

 Différences entre ABAP CDS & HANA CDS 

Le CDS ayant été introduit à la base avec SAP HANA, les spécifications sont pratiquement 

identiques mais les DDL de HANA ne sont pas réutilisables telles quelles avec ABAP CDS ni 

réciproquement (Keller, CDS – One Concept, Two Flavors, 2017).  

Le CDS basé sur SAP HANA fonctionne uniquement sur SAP HANA tandis que le CDS 

basé sur ABAP fonctionne sur la plupart des plate-formes, ainsi que sur SAP HANA (Kessler, 

2017). 

ABAP CDS et HANA CDS possèdent le même objectif, à savoir « représenter les définitions 

de données centrales comme une base commune pour le développement d’applications » 

(Kessler, 2017).  

Quand devrait-on utiliser ABAP CDS et quand devrait-on privilégier HANA CDS ? Dans son 

article « ABAP on SAP HANA. Part IV. Core Data Services », Mohsin Ahmed répond à cette 

question de la façon suivante (Ahmed, 2017) :  

1. Si l’exécution de SAP HANA se fait sans la pile ABAP, l’utilisation de l’ABAP CDS n’est 

pas possible et il faut utiliser HANA CDS ; 

2. Si l’utilisation de la base de données HANA se fait avec une pile ABAP, les scénarii 

suivants sont possibles : 

a. Si l’on souhaite utiliser les entités CDS en tant que types de données ou tester 

les annotations CDS dans ABAP, il faut utiliser ABAP CDS ; 

b. Si l’on ne souhaite pas utiliser les entités CDS dans ABAP, mais que l’on veut 

les transporter comme des objets de l’ABAP repository, il est possible d’utiliser 

ABAP CDS ; 

c. Si l’on ne souhaite pas utiliser les entités CDS en tant que types de données 

dans ABAP ou dans Open SQL, il est possible d’utiliser HANA CDS qui est 

mieux intégré dans SAP HANA. Un accès depuis ABAP est alors possible en 

utilisant SQL grâce à ABAP Database Connectivity (ADBC) et ABAP Managed 

Databse Procedure (AMDP). 
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4. Fonctionnalités SAP CDS 

Les différentes fonctionnalités offertes par SAP CDS sont détaillées dans cette partie 

exclusivement théorique. La mise en pratique est effectuée dans la partie prototype ABAP 

CDS. 

 Jointures 

Les jointures permettent de regrouper des champs venant de deux ou plusieurs tables 

différentes. Les jointures disponibles avec le CDS sont les suivantes : INNER JOIN ou JOIN, 

LEFT OUTER JOIN, RIGHT OUTER JOIN. Les commandes UNION et UNION ALL sont 

également accessibles. Cette fonctionnalité est disponible à partir de SAP NetWeaver 7.4 

SP05 (Swanepoel, New Data Modeling Features in SAP NW ABAP 7.4 SP5, 2017). 

 

Figure 8 : Jointures8 

 Associations 

Les associations CDS peuvent être considérées comme des jointures, du fait que lors de 

l’activation de la vue CDS, les associations sont converties en expressions JOIN. Elles ont la 

particularité d’être réutilisables et permettent de définir des relations entre la vue CDS actuelle 

et une autre source de données qui peut être par exemple une vue classique ou une entité 

CDS. Les relations sont définies à l’aide des cardinalités en utilisant la syntaxe ASSOCIATION 

[MIN..MAX] qui est par défaut fixée à [0..1] si aucune cardinalité n’est définie. Une autre 

particularité des associations est la possibilité d’utiliser des expressions de filtre avec une 

cardinalité (TECHED, 2017). 

                                                      
 
8 Source : Donnée de l’auteur 
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L’intérêt d’utiliser les associations à la place des jointures provient, d’une part, de la 

possibilité de définir les cardinalités et, d’autre part, de la simplification de lecture car « elle se 

rapproche de la pensée conceptuelle » (Santhosh, 2017). Il est important de retenir que, par 

défaut, les associations utilisent la jointure LEFT OUTER JOIN. Comme pour la jointure, elles 

sont disponibles à partir de SAP NetWeaver 7.4 SP05 (Swanepoel, New Data Modeling 

Features in SAP NW ABAP 7.4 SP5, 2017). 

 Annotations 

Les annotations sont définies à l’aide du caractère « @ » dans le document CDS. Elles 

définissent les propriétés et le comportement au moment de l’exécution, comme par exemple 

la manière de sauvegarder les vues, le nom de la vue, la dépendance du client ou la référence 

entre les colonnes. Les annotations permettent d’ajouter des métadonnées (données décrivant 

des autres données) à l’entité CDS (Swanepoel, New Data Modeling Features in SAP NW 

ABAP 7.4 SP5, 2017).  

Les annotations SAP CDS peuvent être soit des annotations ABAP, soit des annotations 

spécifiques à des frameworks (SAP, ABAP CDS - Annotations , 2017). Le détail pour chacune 

d’elles peut être consulté sous le lien suivant :  

https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.1/en-

US/630ce9b386b84e80bfade96779fbaeec.html . 

 Annotations ABAP 

Ces annotations sont évaluées par l’environnement d’exécution ABAP et sont disponibles 

à partir de SAP NetWeaver 7.4 SP05 (Swanepoel, New Data Modeling Features in SAP NW 

ABAP 7.4 SP5, 2017) : 

 AbapCatalog ; 

 AccessControl ; 

 ClientDependent ; 

 ClientHandling ; 

 DataAging ; 

 EndUserText ; 

 Environment ; 

 MappingRole ; 

 Metadata ; 

 Semantics. 

https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.1/en-US/630ce9b386b84e80bfade96779fbaeec.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.1/en-US/630ce9b386b84e80bfade96779fbaeec.html
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 Annotations spécifiques à des frameworks 

Ces annotations sont évaluées durant l’exécution par des frameworks spécifiques tels que 

le détaille l’image suivante. Ces annotations sont disponibles dès la version SAP NetWeaver 

7.5 (Keller, ABAP News for Release 7.50 – Annotations in ABAP CDS, 2017) : 

 Analytics ;  

 AnalyticsDetails ; 

 Consumption ; 

 DefaultAggregation ; 

 EnterpriseSearch ; 

 Hierarchy ; 

 ObjectModel ; 

 OData ; 

 Search ; 

 Semantics ; 

 UI ; 

 VDM. 

 

Figure 9 : Annotations CDS9 

 
 
 
 

                                                      
 
9 Source : https://www.sap.com/documents/2016/02/782ac129-5f7c-0010-82c7-eda71af511fa.html 

https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/c2dd92fb83784c4a87e16e66abeeacbd.html#loioc2dd92fb83784c4a87e16e66abeeacbd
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/fc596c7cb366440a84f9d41f7710d6ca.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/d60c0bf6798a481fb7412bc89934cb8a.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/5e5d319bd1a74552b99a36dfc739f74d.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/2cbeb79d7eb04e628e0745657aa6ed4f.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/23473e6a8b1c4da2b0ba5be4f319a16c.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/896496ecfe4f4f8b857c6d93d4489841.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/ccdb054e4ecf4573829d4ba258cafa72.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/38baf2fc3a8e4ed887b29de738296fa9.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/fbcd3a59a94148f6adad80b9c97304ff.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/f8af07bb0770414bb38a25cae29a12e9.html
https://help.sap.com/viewer/cc0c305d2fab47bd808adcad3ca7ee9d/7.51.0/en-US/efe9c80fc6ba4db692e08340c9151a17.html
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 Autorisations 

Le CDS possède son propre concept d’autorisations à travers le DCL. Le contrôle des 

autorisations se fait à travers les conditions définies dans le CDS et celles définies dans les 

autorisations classiques (PFCG). Pour chaque vue CDS, il est possible de définir un contrôle 

d’accès à l’aide d’un DCL en lien avec les autorisations existantes dans SAP. Si aucune 

autorisation DCL n’est créée pour une entité CDS, celle-ci sera accessible par tous les 

utilisateurs (SAP, SAP - ABAP CDS Development User Guide, 2017). Cette fonctionnalité a 

été introduite à partir de la version SAP NetWeaver 7.40 SP10 mais n’a réellement été 

fonctionnelle qu’à partir de la version 7.50 (Keller, CDS – One Concept, Two Flavors, 2017). 

 

Figure 10 : Autorisations CDS10 

  

                                                      
 
10 Source : https://www.sap.com/documents/2016/02/782ac129-5f7c-0010-82c7-eda71af511fa.html 
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 Extension de vues 

L’extension de vues est basée sur le concept hiérarchique de « vue sur vue » afin 

d’optimiser un ensemble de résultats en transférant un minimum de données. Grâce à ces 

extensions de vues, il est par exemple possible d’ajouter des colonnes supplémentaires, des 

expressions ou des associations à une vue existante (TECHED, 2017). Cette fonctionnalité 

est disponible à partir de la version Netweaver 7.40 SP08 (Keller, ABAP News for 7.40, SP08 

– ABAP Core Data Services (CDS), 2017). 

 

Figure 11 : Extension de vues CDS11  

                                                      
 
11 Source : https://assets.cdn.sap.com/sapcom/docs/2016/02/bedb9729-5f7c-0010-82c7-eda71af511fa.pdf 
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5. Prototype ABAP CDS 

La réalisation du prototype a été réalisée sur la version d’Eclipse Neon.3 Release (4.6.3) et 

les versions SAP ERP 6.08 (SAP ERP 6.0 EHP8) et SAP NetWeaver 7.5 SP06. Il a été 

convenu avec Monsieur Frédéric Morand de créer de nouvelles tables pour les tests, 

lesquelles sont détaillées dans les annexes. Ces tables simulent des commandes clients 

d’instruments ou d’accessoires musicaux. 

 Configuration de l’environnement Eclipse 

Cette partie permet de configurer l’environnement de développement Eclipse en y ajoutant 

les outils de développement nécessaires, la connexion au système SAP et la création d’un 

nouveau projet. 

 Outils de développement ABAP 

Afin de pouvoir utiliser l’environnement de développement ABAP sur Eclipse, il est 

nécessaire d’ajouter le plug-in de développement ABAP. Les étapes pour l’installation de l’ADT 

(ABAP Development Tools) sont les suivantes (olgadolinskaja, 2017) : 

 Télécharger un environnement de développement Eclipse ; 

 Une fois l’environnement installé, ouvrir Eclipse et utiliser le menu : Help > Install 

New Software ; 

 

Figure 12 : Installation ADT Tools - Install New Software12 

                                                      
 
12 Source : Donnée de l’auteur sur Eclipse Neon 
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 Sélectionner le bouton Add pour insérer l’URL ; 

 

Figure 13 : Installation ADT Tools - Add link13 

 Dans la fenêtre Add Repository, insérer par exemple comme nom « Neon » et 

comme URL «https://tools.hana.ondemand.com/neon » ; 

 

Figure 14 : Installation ADT Tools - Add Repository14 

  

                                                      
 
13 Source : Donnée de l’auteur sur Eclipse Neon 
14 Source : Donnée de l’auteur sur Eclipse Neon 

LENOVO
Stamp
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 Dans la liste des outils de développement disponibles, sélectionner « ABAP 

Development Tools for SAP NetWeaver » ; 

 

Figure 15 : Installation ADT Tools - Available Software15 

 Dans la fenêtre Install Details, vous pouvez visualiser les éléments qui seront 

installés ; 

 

Figure 16 : Installation ADT Tools - Review Items16 

                                                      
 
15 Source : Donnée de l’auteur sur Eclipse Neon 
16 Source : Donnée de l’auteur sur Eclipse Neon 
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 Dans la fenêtre Review Licenses, la dernière étape consiste à accepter les termes 

du contrat de licence ; 

 

Figure 17 : Installation ADT Tools - Review Licenses17 

 Une fois l’installation terminée, redémarrer Eclipse. 

 Nouveau projet ABAP 

Avant de créer un nouveau projet ABAP, il est nécessaire de modifier la perspective JAVA 

en ABAP afin d’avoir accès à tous les objets de développement : 

1. Dans le menu, sélectionner : Window > Perspective > Open Perspective > Other ; 

 

Figure 18 : Configuration Eclipse - Modification perspective18 

 
 

                                                      
 
17 Source : Donnée de l’auteur sur Eclipse Neon 
18 Source : Donnée de l’auteur sur Eclipse Neon 
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2. Dans la liste des perspectives disponibles, sélectionner « ABAP ». 

 

Figure 19 : Configuration Eclipse - Perspective ABAP19 

Il est maintenant possible de créer un nouveau projet ABAP, en utilisant le chemin suivant : 

File > New > ABAP Project. 

 

Figure 20 : Nouveau projet ABAP20 

Le premier écran permet de sélectionner une connexion SAP pour lier le projet ABAP. 

                                                      
 
19 Source : Donnée de l’auteur sur Eclipse Neon 
20 Source : Donnée de l’auteur sur Eclipse Neon 
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Figure 21 : Nouveau projet ABAP - System Connection21 

Les paramètres de connexion sont automatiquement récupérés en fonction du système 

préalablement sélectionné. 

  

Figure 22 : Nouveau projet ABAP - Connection Settings22 

                                                      
 
21 Source : Donnée de l’auteur sur Eclipse Neon 
22 Source : Donnée de l’auteur sur Eclipse Neon 
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L’écran suivant requiert d’insérer les informations relatives à la connexion SAP. 

 

Figure 23 : Nouveau projet ABAP - Logon to System23 

Le nom du projet est alors entré et un package existant sur SAP doit lui être assigné à l’aide 

du bouton Add.  

 

Figure 24 : Nouveau projet ABAP - Project Name and Packages24 

                                                      
 
23 Source : Donnée de l’auteur sur Eclipse Neon 
24 Source : Donnée de l’auteur sur Eclipse Neon 
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 Création d’une entité CDS 

La création des entités CDS s’exécute de la manière suivante (D028018, 2017) (Admin, 

2017) : 

 Dans le projet ABAP, sélectionner le nœud du sommet, faire un clic droit et suivre le 

chemin : New > ABAP Repository Object ; 

 

Figure 25 : Création d’une entité CDS25 

 Dans la fenêtre suivante, ouvrir le dossier Core Data Services et sélectionner Data 

Definition. La création d’une Data Definition permet de développer une entité CDS. 

Notez que selon la version d’ADT, Data Definition se nomme DDL source ; 

 

Figure 26 : Création entité CDS – ABAP Repository Object26 

                                                      
 
25 Source : Donnée de l’auteur sur Eclipse Neon 
26 Source : Donnée de l’auteur sur Eclipse Neon 
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 Entrer les informations telles que le nom, en commençant par « Z », et une 

description ; 

 

Figure 27 : Création entité CDS - Data Definition27 

 Sélectionner un ordre de transport ; 

 

Figure 28 : Création entité CDS - Transport Request28 

                                                      
 
27 Source : Donnée de l’auteur sur Eclipse Neon 
28 Source : Donnée de l’auteur sur Eclipse Neon 
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 Sélectionner un template. Une sélection de modèles est à disposition pour créer 

une vue CDS avec l’affichage de la syntaxe par défaut. Les modèles existants sont 

les vues simples, avec jointure, avec association, avec paramètres, ainsi que les 

vues étendues. 

 

Figure 29 : Création entité CDS - Template29 

L’image ci-dessous présente les éléments du template Define View qu’il est possible de 

modifier. 

 

Figure 30 : Vue CDS30 

Les quatre points mis en évidence par un chiffre en rouge sont listés ci-après : 

 Les annotations obligatoires sont créées automatiquement avec la vue CDS (les 

autres annotations seront détaillées dans la section 5.4) ; 

                                                      
 
29 Source : Donnée de l’auteur sur Eclipse Neon 
30 Source : Donnée de l’auteur sur Eclipse Neon 
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 Les déclarations de la base de données : 

a. Le type de la vue (define view) ; 

b. Le nom de la vue CDS (Z_CDS_Select) ; 

c. La source (as select from), suivie soit d’une table, soit d’une vue, avec 

éventuellement un alias (as) ; 

d. L’ajout de jointures ou d’associations (détaillées dans les sections 5.5 et 5.6). 

 Les champs à sélectionner et les éventuelles fonctions et expressions. Il est 

possible d’utiliser le caractère « * » pour afficher tous les champs. Les alias peuvent 

également être ajoutés à chaque champ. Le mot clé key, inséré au début de la liste 

des champs, permet de définir l’élément comme clé de l’entité CDS ; 

 L’ajout d’éventuelles restrictions de sélection et d’instructions d’agrégation. 

L’enregistrement de la vue CDS et son activation  sont maintenant possibles. La 

visualisation du résultat est alors disponible en exécutant la vue . 

 

Figure 31 : Résultat de la requête CDS31 

À la suite de l’activation, deux dossiers sont créés dans le package : 

 Core Data Services, avec comme sous-dossier Data Definitions contenant les 

entités CDS ; 

 Views, créé en tant que sous-dossier de Dictionary, où les vues SQL sont 

automatiquement créées. 

En ouvrant une vue SQL, il est possible de naviguer à travers les différents onglets afin 

d’afficher par exemple les champs sélectionnés dans la source DDL, les éventuelles jointures 

ou les conditions de sélection. Il est important de noter que le message d’avertissement se 

trouvant au fond de la fenêtre indique que « les vues SQL ne sont supportées que de manière 

                                                      
 
31 Source : Donnée de l’auteur sur Eclipse Neon 
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limitée par SE11 ». Les modifications des vues SQL ne peuvent se faire qu’au travers de la 

vue CDS sous Eclipse. 

 

Figure 32 : Dictionary ABAP -Vue CDS32 

L’image ci-dessous résume les configurations possibles lors de la construction d’une vue 

CDS :  

 

Figure 33 : Construction d’une vue CDS - Résumé33 

                                                      
 
32 Source : Donnée de l’auteur sur SAP 
33 Source : https://www.stechies.com/userfiles/CDS-source-view-2.jpg 
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 Utilisation d’une vue CDS dans un programme ABAP 

L’utilisation d’une vue CDS dans un programme ABAP se fait de la même manière que pour 

une requête Open SQL avec comme source son nom. 

 

Figure 34 : Programme ABAP avec vue CDS34 

 

 Annotations 

Pour cet exemple d’annotations, le choix s’est porté sur la table « ztt_material » afin de 

pouvoir utiliser une annotation de type @Semantics pour référencer les champs currency et 

price, en plus des annotations ajoutées automatiquement à la création. 

 

Figure 35 : Annotations CDS35 

                                                      
 
34 Donnée de l’auteur sur Eclipse Neon 
35 Source : Donnée de l’auteur sur Eclipse Neon 

LENOVO
Stamp
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Les points mis en évidence par un chiffre en rouge sont explicités ci-après : 

 Cette annotation est obligatoire car elle permet de définir le nom de la vue SQL ; 

 Cette annotation définit si les conditions de filtrage doivent être comparées avec les 

expressions d’une vue. Les valeurs possibles sont : 

a. True : La condition du filtre est comparée. Si elle correspond, la jointure 

associée est créée une seule fois. Les performances sont donc améliorées ; 

b. False : Une jointure est créée séparément pour chaque condition de filtre. 

 Cette troisième annotation permet de spécifier si une autorisation doit être effectuée 

sur la vue CDS à travers un DCL. Les choix suivants sont disponibles : 

a. #NOT_ALLOWED : Aucun contrôle n’est effectué ; 

b. #CHECK : Un contrôle d’accès doit être effectué ; 

c. #NOT_REQUIRED : Idem que pour la valeur #CHECK, à la différence que si 

aucun DCL n’est attribué à la vue CDS, il n’y a pas de message d’avertissement 

sur la syntaxe. 

 Cette annotation vise à décrire brièvement la vue CDS ; 

 Celle-ci donne une brève description de l’élément suivant ; 

 Cette annotation permet de définir l’élément suivant comme une clé de devise 

(currency key) ; 

 Enfin, la dernière annotation définit le champ lié avec la clé de devise 

précédemment établie. 

 Jointures 

Pour la création d’une jointure, il est nécessaire de créer une nouvelle entité CDS en 

sélectionnant le template Define view with join.  

Dans l’exemple ci-dessous, une jointure de type JOIN est utilisée pour lier la table 

« ztt_order » à « ztt_customer ». La condition ON permet de définir la condition pour lier les 

deux tables, soit à travers un nom commun, soit à travers des clés étrangères. 
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Figure 36 : Jointure CDS36 

 Associations 

Pour la création d’une association, il est nécessaire de créer une nouvelle entité CDS en 

sélectionnant le template Define view with Association.  

Dans l’exemple ci-dessous, l’association est utilisée pour lier la table « ztt_customer » à 

« ztt_order ». Comme pour la jointure, la condition ON permet de définir la condition pour lier 

les deux tables. La cardinalité de l’association est définie après le mot clé association et son 

alias doit comporter le caractère « _ » devant le nom. Il est possible d’exposer l’association 

pour pouvoir la réutiliser dans une autre entité CDS, comme sous le point 1 de l’image. 

 

Figure 37 : Association CDS37 

Dans l’exemple suivant, l’entité CDS « Z_CDS_Association » est utilisée comme référence, 

afin de pouvoir réutiliser l’association préalablement exposée et lui ajouter un filtre à travers 

                                                      
 
36 Source : Donnée de l’auteur sur Eclipse Neon 
37 Source : Donnée de l’auteur sur Eclipse Neon 
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une cardinalité. Ci-dessous, le filtre permet d’afficher l’id de la commande correspondant à l’id 

du client DUM. 

 

Figure 38 : Association CDS - Réutilisation et filtre38 

Les associations peuvent être récupérées dans un programme ABAP à travers la syntaxe 

suivante : 

  

Figure 39 : Association CDS - Programme ABAP39 

 Autorisations 

Pour limiter les résultats retournés par l’entité CDS selon les utilisateurs, il est possible de 

créer un contrôle d’accès, en relation avec un objet d’autorisation existant. Le détail sur l’objet 

d’autorisation utilisé dans cet exemple est disponible dans les annexes.  

Sous Eclipse, la création d’une source DCL est effectuée en créant un nouveau contrôle 

d’accès, comme illustré par l’image ci-dessous. 

 

Figure 40 : Création d'un contrôle d'accès40 

Comme pour la création des entités CDS, un nom, une description et l’ordre de transport 

                                                      
 
38 Source : Donnée de l’auteur sur Eclipse Neon 
39 Source : Donnée de l’auteur sur Eclipse Neon 
40 Source : Donnée de l’auteur sur Eclipse Neon 
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doivent être attribués. L’image ci-dessous affiche le template mis à disposition. 

 

Figure 41 : Contrôle d'accès - Templates41 

 

Ci-dessous est présenté un exemple d’autorisation avec, pour chaque point à définir (en 

rouge sur l’illustration), une explication. 

 

Figure 42 : Contrôle d'accès CDS42 

 Le label d’information, lequel doit être explicite ; 

 Le nom du rôle ; 

 Le nom de la vue CDS sur laquelle s’applique le contrôle des autorisations ; 

 Le champ sur lequel l’autorisation doit être vérifiée ; 

 Les détails relatifs à l’objet d’autorisation. Le premier champ entre parenthèses 

                                                      
 
41 Source : Donnée de l’auteur sur Eclipse Neon 
42 Source : Donnée de l’auteur sur Eclipse Neon 
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correspond au nom de l’objet d’autorisation et les deux suivants aux champs définis 

dans l’objet d’autorisation. 

Une fois le DCL activé, un sous-dossier Access Controls est créé sous le dossier Core Data 

Services. Pour l’utiliser, il suffit de modifier dans la vue CDS l’annotation relative aux 

autorisations en y ajoutant le mot clé #CHECK. 

 

Figure 43 : Contrôle d'accès CDS - Autorisation43 

Sur la base du rôle simple défini sur SAP (voir annexe II), le résultat au moment de 

l’exécution de la vue CDS affiche uniquement le client Frédéric Morand.  

 

Figure 44 : Résultat avec le contrôle d'accès44 

Sans contrôle d’autorisation (#NOT_ALLOWED), le résultat affiche tous les clients. 

 

Figure 45 : Résultat sans le contrôle d'accès45 

 
 

                                                      
 
43 Source : Donnée de l’auteur sur Eclipse Neon 
44 Source : Donnée de l’auteur sur Eclipse Neon 
45 Source : Donnée de l’auteur sur Eclipse Neon 
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 Extension de vues 

La création d’une extension de vues est relativement simple. Comme pour les autres 

fonctionnalités, il faut créer une entité CDS en sélectionnant le template Extend view.  

Dans ce template, à la suite du terme extend view, il faut indiquer la vue CDS à laquelle 

l’extension sera ajoutée. Dans l’exemple ci-dessous, la vue CDS de base est 

« Z_CDS_JOINS », laquelle joint les tables « ztt_order_details », « ztt_order » et 

« ztt_material ». L’extension permet de calculer le prix total.  

 

Figure 46 : Extension CDS46 

Une fois l’extension activée, en analysant la vue CDS de base, une spirale apparaît, 

indiquant que l’entité possède des extensions de vue. 

 

Figure 47 : Signe d'une extension existante47 

En pointant la souris sur la spirale, une fenêtre affiche avec les informations suivantes : 

nom de la vue CDS et nom de l’extension.  

 

Figure 48 : Affichage du nom de l'extension48 

A l’exécution de la vue CDS « Z_CDS_JOINS », le résultat affiché contient les champs de 

                                                      
 
46 Source : Donnée de l’auteur sur Eclipse Neon 
47 Source : Donnée de l’auteur sur Eclipse Neon 
48 Source : Donnée de l’auteur sur Eclipse Neon 
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la vue de base avec les éléments de l’extension (Total_Price). 

 

Figure 49 : Résultat de l'extension de vues49 

 Paramètres 

Pour cet exemple utilisant les paramètres, toutes les tables sont liées, permettant ainsi 

d’afficher la totalité des informations concernant une commande, selon le nom et le prénom 

passés en paramètres. 

 

Figure 50 : Paramètres CDS50 

Les points mis en évidence par un chiffre en rouge sont explicités ci-après : 

1. L’ajout de paramètres se fait avant la sélection des tables en leur assignant un nom et 

en spécifiant leur type. Dans l’exemple ci-dessus, les types choisis sont des Data 

Elements du DDIC ; 

                                                      
 
49 Source : Donnée de l’auteur sur Eclipse Neon 
50 Source : Donnée de l’auteur sur Eclipse Neon 

http://www.rapport-gratuit.com/
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2. L’utilisation des paramètres à travers la syntaxe $parameters suivi du nom du paramètre 

peut être utilisé comme champ à afficher ; 

3. A travers la clause where, l’affichage est restreint en fonction des paramètres. 

Au moment de l’exécution, une fenêtre s’affiche et demande d’insérer le nom et le prénom 

du client. 

 

Figure 51 : Paramètres CDS - Insertion des valeurs51 

Le résultat affiche uniquement les données du client passé en paramètres :  

 

Figure 52 : Paramètres CDS - Résultat52 

  

                                                      
 
51 Source : Donnée de l’auteur sur Eclipse Neon 
52 Source : Donnée de l’auteur sur Eclipse Neon 
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L’utilisation des paramètres dans un programme ABAP se fait de la manière suivante : 

 

Figure 53 : Paramètres CDS - Utilisation dans un programme ABAP53 

 Gestion des langues  

Avec l’utilisation de la syntaxe $session.system_language dans la clause where, il est 

possible d’afficher les résultats selon la langue de la session. Dans l’exemple ci-dessous, les 

tables « ztt_material » et « ztt_material_t » (ayant le nom des matériaux en français et en 

anglais) sont utilisées. 

 

Figure 54 : Gestion des langues CDS54 

  

                                                      
 
53 Source : Donnée de l’auteur sur Eclipse Neon 
54 Source : Donnée de l’auteur sur Eclipse Neon 
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6. Prototype HANA CDS  

La réalisation du prototype est faite sur la version d’Eclipse Neon.3 Release (4.6.3) et la 

version SAP S/4HANA 1511 SP02. Comme la création des entités CDS peut être faite de la 

même manière que pour ABAP CDS sur S/4HANA, il est plus intéressant de présenter 

comment créer des tables .hdbdd en utilisant le CDS sur SAP HANA. Pour ce faire, un compte 

avec des accès restreints (se référer à l’image ci-dessous) a été créé pour HANA DB et HANA 

Studio. 

 

Figure 55 : Prototype HANA CDS - Droits de l'utilisateur55 

 Configuration de l’environnement Eclipse 

Cette partie permet de configurer l’environnement de développement Eclipse en y ajoutant 

les outils de développement et la connexion à la base de données. 

 Outils de développement HANA 

L’installation du plug-in de développement HANA est identique à celui d’ABAP à l’exception 

des outils de développement à sélectionner, soit dans ce cas « SAP Cloud Platform Tools » et 

« SAP HANA Tools » (uiravikumar@gmail.com, 2017). 

                                                      
 
55 Source : Donnée de l’auteur 

LENOVO
Stamp



Marlène Duc 

© HES-SO Valais / Wallis 2017 39 

 

Figure 56 : Installation ADT Tools "Available Software" HANA56 

 Ajouter un système SAP HANA à Eclipse 

Les artefacts de développement d’applications sont stockés et gérés à travers SAP HANA 

repository. Afin de pouvoir s’y connecter, il faut ajouter un système dans Eclipse.  

Avant de pouvoir ajouter un système, il faut changer de perspective pour SAP HANA, en 

suivant le chemin : Window > Perspective > Open Perspective > Other > SAP HANA 

Development (Portal, 2017). 

                                                      
 
56 Source : Donnée de l’auteur sur Eclipse Neon 
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Figure 57 : Configuration Eclipse - Perspective HANA57 

L’ajout d’un nouveau système se fait via l’onglet « Systems ». 

 

Figure 58 : Configuration Eclipse - Nouveau système HANA58 

Les informations relatives au système doivent être spécifiées.  

 

Figure 59 : Configuration Eclipse - Spécification du système HANA59 
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La dernière étape de la configuration consiste à spécifier les informations relatives à la 

connexion.  

 

Figure 60 : Configuration Eclipse - Propriétés de connexion HANA60 

Suite à l’ajout du nouveau système, le Workspace est automatiquement ajouté sous l’onglet 

Repositories.  

 

Figure 61 : Configuration Eclipse - Repositories Workspace HANA61 

 Création des tables 

La description d’un modèle de persistance se fait à travers un document CDS. Celui-ci 

correspond à un fichier source contenant la définition des objets dont la création est souhaitée 

dans le catalogue SAP HANA (Portal, 2017). 
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La création d’un document CDS se réalise de la manière suivante (Portal, 2017) : 

 Sous l’onglet Repositories, sélectionner le package sous lequel le document doit 

être créé en utilisant le clic droit et en suivant le chemin : New > Other > Database 

Development > DDL Source File ; 

 

Figure 62 : Création d’un document CDS62 

 Insérer le nom du document CDS. 

 

Figure 63 : Création d'un document CDS - Sélection fichier63 
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L’image ci-dessous présente les éléments à insérer dans le document CDS pour la création 

des tables. 

 

Figure 64 : Document CDS64 

Les points mis en évidence par un chiffre en rouge sont explicités ci-après : 

 Namespace : le nom du package repository dans lequel le document CDS doit être 

créé ; 

 Annotations : les annotations disponibles pour le document CDS sont :  

a. @Catalog.index : utilisé pour définir un index ; 

b. @Catalog.tableType : permet de spécifier le type de la table, soit en colonne, 

soit en ligne, soit temporaire ; 

c. @nokey : permet d’indiquer que l’entité ne possède pas de clé primaire ; 

d. @Schema : indique le nom du schéma à utiliser pour stocker les entités ; 

e. @GenerateTableType : lorsqu’une structure type est définie, table type est 

généré dans le catalogue. Il est possible d’utiliser une structure type sans 

générer de table type dans le catalogue en lui assignant la valeur false ; 

f. @SearchIndex : utilisé pour définir quels éléments de la colonne doivent être 

indexés pour les fonctions de recherche ; 

g. @WithStructuredPrivilegeCheck : permet de contrôler l’accès aux données 

(lors de la création d’une vue) selon les privilèges définis avec le DCL ; 
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 Context : le contexte permet de grouper des artefacts. Un document CDS possède 

un seul contexte à la racine, mais dans celui-ci, il est possible d’en ajouter d’autres 

selon les besoins ; 

 Type : il est possible de définir des types dans le document CDS ;  

 Entity : l’entité est utilisée pour créer de nouvelles tables en y insérant le nom des 

champs et leurs types ; 

 Associations : elles permettent de définir les relations entre les entités. Si aucune 

cardinalité n’est précisée, par défaut, elle correspond à [0..1] et la clé étrangère est 

définie automatiquement en utilisant la clé primaire de l’entité associée. Il est 

également possible de spécifier les clés étrangères, comme illustré par la figure ci-

après : 

 

Figure 65 : Documents CDS - Association65 

Une fois que le document est complet, il faut l’activer en choisissant Activate. 

 

Figure 66 : Document CDS - Activation66 
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Suite à l’activation, il est possible de constater sous l’onglet Systems la création des tables. 

 

Figure 67 : BD HANA - Tables67 
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7. Avantages et inconvénients par rapport à l’ABAP Dictionary 

Il est important de relever que le CDS a été inventé par SAP pour pallier l’incapacité d’ABAP 

Dictionary et de SAP HANA Studio de répondre aux besoins de toutes les applications métier 

(Ahmed, 2017). Evidemment, selon les besoins des entreprises, le CDS n’est pas toujours un 

avantage. Par exemple, si une vue n’est utilisée qu’une seule fois, la création de vues CDS 

n’est pas réellement nécessaire et n’apporte pas d’avantages par rapport à une vue normale. 

Cependant, si les besoins demandent de pouvoir réutiliser une vue ou demandent des 

capacités sémantiques ou techniques supérieures à celles offertes par Open SQL, le CDS est 

un avantage. 

Parmi les fonctionnalités offertes et décrites dans le présent rapport, les annotations 

permettent un usage flexible dans des contextes différents (OData, Business Logic,…) et 

constituent par conséquent un apport intéressant du CDS. La possibilité de gérer les 

autorisations directement sur la vue CDS offre également l’avantage de ne plus avoir besoin 

de les gérer dans un programme ABAP. De plus, l’extension de vues permet non seulement 

d’optimiser un ensemble de résultats en transférant un minimum de données, mais également 

d’ajouter des colonnes supplémentaires, des expressions ou des associations à une vue 

existante. 

 SAP ne délaisse pas pour autant l’ABAP Dictionary, en proposant des améliorations 

d’Open SQL afin d’accroître les performances et de se rapprocher de l’Open SQL. 

Cependant et comme démontré par Sujin Appukuttan dans son post du 9 septembre 2016, 

« ABAP new Open SQL and CDS runtime », les améliorations d’Open SQL présentent un 

temps d’exécution légèrement plus rapide que les vues CDS (résultat en microsecondes) 

(Appukuttan, 2017) :  

 

Figure 68 : Temps d'exécution Open SQL VS CDS View68 
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8. Conclusion 

 Synthèse générale 

L’étude théorique du CDS et de ses fonctionnalités a permis de maîtriser son concept et 

les possibilités qu’il offre. La partie pratique a permis de vérifier l’exactitude des recherches, 

d’adapter la partie théorique et de mettre en pratique les différentes fonctionnalités du CDS à 

travers deux prototypes. 

Dans le cadre de ce travail, il m’a été permis de connaître les nouveaux systèmes SAP tels 

que SAP HANA, S4/ HANA et surtout le CDS. Un large choix de documentation officielle, de 

blogs, de vidéos et de tutoriels est accessible. Cela demande toutefois beaucoup de lectures 

et un important tri d’informations pour en ressortir les plus pertinentes et les mieux adaptées 

aux besoins de la présente étude.  

Suite aux diverses recherches et au développement des prototypes, on peut conclure que 

SAP CDS possède des avantages majeurs par rapport à l’ABAP Dictionary. D’une part, il 

propose des améliorations et de nouvelles fonctions et expressions, mais surtout, SAP CDS 

propose trois fonctionnalités particulièrement séduisantes : les annotations, la gestion des 

autorisations et les associations. Les annotations permettent par exemple de connecter des 

tables existantes à de nouvelles technologies telles que OData et UI5. De son côté, la gestion 

des autorisations permet de définir les autorisations directement sur une vue et non sur un 

programme. Enfin, les associations définissent les relations entre les tables à l’aide des 

cardinalités. 

Le CDS s’intègre à la gestion du cycle de vie des produits SAP et aux différentes 

technologies utilisées par SAP, notamment SAP NetWeaver Gateway. Cependant, selon les 

besoins des entreprises, le CDS n’apportera pas de plus-value et il sera préférable de rester 

sur ABAP Dictionary. 

 Evolutions futures 

Les évolutions futures de ce nouveau concept sont très prometteuses et devraient permettre 

de convaincre les entreprises. Un aspect pourrait toutefois les dissuader d’adopter cette 

nouvelle technologie : sa mise en place et son intégration qui nécessitent des ressources 

humaines et financières importantes. L’avenir du CDS dépend donc de la volonté des 

entreprises clientes de SAP d’utiliser ce nouveau concept et des appréciations positives ou 

négatives qu’elles feront après son intégration.  
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Annexe I : Tables de la base de données 

Les différentes tables créées et utilisées pour le prototype ABAP CDS, ainsi que leur contenu, sont disponibles ci-après. 

 

Figure 69 : Annexe I - Tables de base de données69 

 

                                                      
 
69 Source : Donnée de l’auteur 
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Figure 70 : Annexe I - Contenu des tables de la base de données70 

 

                                                      
 
70 Source : Donnée de l’auteur 
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Annexe II : Objet d’autorisation 

Ci-dessous est présenté le détail des éléments créés pour les autorisations du prototype 

ABAP CDS (Prasad, 2017) (Alyapyshev, 2017) : 

 

Figure 71 : Annexe II - Classe objet71 

 

Figure 72 : Annexe II - Rôle simple et autorisations72 

  

                                                      
 
71 Source : Donnée de l’auteur sur SAP 
72 Source : Donnée de l’auteur sur SAP 
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Annexe III : Aides et astuces de développement 

Ci-dessous sont présentées quelques aides et astuces disponibles sous Eclipse 

(Swanepoel, New ABAP CDS Tools in SAP NetWeaver AS ABAP 7.5, 2017) (SAP, SAP - ABAP 

CDS Development User Guide, 2017). 

Code completion 

En utilisant CTRL + ESPACE dans la zone prévue pour la sélection des champs, il est 

possible d’insérer tous les éléments de la base de données en un clic. Cette aide est plus utile 

pour les vues avec jointures ou associations qui n’autorisent pas la sélection de tous les 

éléments à travers l’utilisation du caractère « * ». 

 

Figure 73 : Annexe III - Code completion73 

Wizard pour les clauses ON 

Pour définir les clauses ON des jointures et des associations, il existe un wizard. Pour 

l’utiliser, il faut placer le curseur de la souris à la suite du mot clé ON et utiliser les touches du 

clavier CTRL+1. 

 

Figure 74 : Annexe III - Wizard pour les clauses « ON »74 

                                                      
 
73 Source : Donnée de l’auteur sur Eclipse Neon 
74 Source : Donnée de l’auteur sur Eclipse Neon 
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Il est alors possible de définir les conditions soit en utilisant les noms, soit en utilisant les 

clés étrangères, soit en utilisant l’action glisser/déposer un élément de la première table vers 

la deuxième. 

 

Figure 75 : Annexe III - Définition de la clause « ON »75 

Editeur Graphique 

Il est possible d’afficher un éditeur graphique pour visualiser la source DDL et les relations 

existantes en suivant le chemin : clic droit de la souris sur une source DDL > Open With > 

Graphical Editor. 

Ci-dessous se trouve un exemple affichant que la vue CDS « Z_CDS_JOIN » contient des 

annotations ( ) et des restrictions ( ). Les autres éléments sont grisés ( ), ce qui 

indique qu’ils ne sont pas utilisés. En observant les liens, on constate que cette vue utilise les 

données venant de la table « ztt_order » et qu’il existe une jointure ( ) vers la table 

« ztt_customer ».  

 

Figure 76 : Annexe III - Editeur Graphique76 

                                                      
 
75 Source : Donnée de l’auteur sur Eclipse Neon 
76 Source : Donnée de l’auteur sur Eclipse Neon 
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Active Annotations Views 

Cet affichage permet de lister tous les éléments utilisés dans une vue CDS en suivant le 

chemin : clic droit de la souris sur une source DDL > Open With > Active Annotations. 

 

Figure 77 : Annexe III - Active Annotations Views77 

L’image ci-dessous résume les informations affichées grâce à Active Annotations Views. 

 

Figure 78 : Annexe III - Active Annotations Views Details78  

                                                      
 
77 Source : Donnée de l’auteur sur Eclipse Neon 
78 Source : https://help.sap.com/viewer/f2e545608079437ab165c105649b89db/7.5.6/en-

US/45ba68d3b4924a97ad2dc598e756968e.html 

https://help.sap.com/viewer/f2e545608079437ab165c105649b89db/7.5.6/en-US/45ba68d3b4924a97ad2dc598e756968e.html
https://help.sap.com/viewer/f2e545608079437ab165c105649b89db/7.5.6/en-US/45ba68d3b4924a97ad2dc598e756968e.html
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Annexe IV : Insertion de données dans les tables HANA  

L’insertion de données dans les tables HANA peut se faire soit à l’aide d’un script SQL soit 

à l’aide d’un fichier CSV. 

Script SQL (shyamuthaman, SAP HANA SQL Script INSERT, 2017) 

Depuis l’onglet Systems, il faut sélectionner l’icône SQL pour ouvrir la console SQL. 

 

Figure 79 : Annexe IV - Ajout d'un nouveau Script SQL79 

Dans la console SQL, l’insertion des données se fait à l’aide de la requête INSERT 

suivante : INSERT into tables values (value1, value2, value3);. 

 

Figure 80 : Annexe IV - Script SQL80 

Il est alors possible d’afficher les données de la table en utilisant Open Data Preview et de 

vérifier la bonne insertion des données. 

 

Figure 81 : Annexe IV - Open Data Preview81 

                                                      
 
79 Source : Donnée de l’auteur sur Eclipse Neon 
80 Source : Donnée de l’auteur sur Eclipse Neon 
81 Source : Donnée de l’auteur sur Eclipse Neon 

LENOVO
Stamp
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Figure 82 : Annexe IV – Données de la table82 

Fichier CSV (shyamuthaman, Insert data into custom tables – Flat file loads to SAP HANA, 

2017) 

Pour pouvoir importer un fichier csv, il est important que le format de son enregistrement 

soit correct : « CSV (séparateur : point-virgules)(*.csv) ». 

 

Figure 83 : Annexe IV - Format du fichier csv83 

L’importation du fichier csv se fait sous Eclipse en utilisant le chemin suivant : File > 

Import... >SAP HANA Content > Data from Local File. 

 

Figure 84 : Annexe IV - Import Data from Local File84 

                                                      
 
82 Source : Donnée de l’auteur sur Eclipse Neon 
83 Source : Donnée de l’auteur 
84 Source : Donnée de l’auteur sur Eclipse Neon 
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L’écran suivant permet de sélectionner le système dans lequel le fichier csv doit être 

importé. 

 

Figure 85 : Annexe IV - Import Data from Local File - Target System85 

L’écran suivant permet de définir les propriétés pour l’importation. 

 

Figure 86 : Annexe IV - Import Data from Local File - Define Import Properties86  

                                                      
 
85 Source : Donnée de l’auteur sur Eclipse Neon 
86 Source : Donnée de l’auteur sur Eclipse Neon 
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Les points mis en évidence par un chiffre en rouge sont explicités ci-après : 

 Insérer le chemin du fichier csv à importer ; 

 Définir le type de séparateur utilisé dans le fichier csv ; 

 Si un en-tête existe dans le fichier, cocher la case et indiquer sa position ; 

 En cochant la case, toutes les données sont importées. Sinon, il est possible 

d’indiquer les lignes à importer ; 

 Sélectionner la table où les données doivent être importées. 

L’écran suivant permet de mapper les données entre le fichier csv et la table. Le mappage 

se fait en glissant-déposant les champs du fichier csv vers ceux de la table. 

 

Figure 87 : Annexe IV - Import Data from Local File - Mappings87 

 

 

                                                      
 
87 Source : Donnée de l’auteur sur Eclipse Neon 
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Le dernier écran résume les données importées et les éventuelles données déjà existantes 

dans la table. 

 

Figure 88 : Annexe IV - Import Data from Local File - Summary88 

Il est alors possible d’afficher les données de la table en utilisant Open Data Preview et de 

vérifier la bonne insertion des données. 

 

Figure 89 : Annexe IV - Résultat 89 

  

                                                      
 
88 Source : Donnée de l’auteur sur Eclipse Neon 
89 Source : Donnée de l’auteur sur Eclipse Neon 
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Annexe V : Gestion de projet 

 Tout au long de la réalisation de ce travail, la méthodologie Agile étudiée durant le cursus 

académique a été adaptée au fait que le projet a été réalisé par une seule personne. 

Seuls certains points de cette méthodologie ont été retenus et utilisés de manière adaptée 

aux besoins. En début de travail, un cahier des charges a été mis en place, relevant les 

objectifs visés. L’utilisation de Sprints n’a pas été mise en place mais a été remplacée par des 

rapports hebdomadaires traitant des objectifs et de leur réalisation, en spécifiant les problèmes 

rencontrés et les solutions trouvées. Dans la méthodologie Agile, les membres d’une équipe 

connaissent le domaine et les capacités de l’équipe à effectuer les tâches et sont 

généralement aptes à évaluer le temps nécessaire à la réalisation de chaque tâche. Devant 

travailler sur un sujet inconnu, j’ai choisi l’option de ne pas évaluer au départ. En revanche, j’ai 

tenu un journal hebdomadaire des heures consacrées à chaque tâche. Les rendez-vous avec 

le Professeur Dr. Werner Maier étaient fixés chaque semaine ou chaque deux semaines en 

fonction des tâches à effectuer, en vue de faire régulièrement le point sur l’avancement des 

travaux. En cas de question essentielle entre les différents rendez-vous, il était facile de 

prendre contact avec lui ou avec Monsieur Frédéric Morand.  

Le cahier des charges initial a été modifié pour la partie du prototype HANA CDS. S’il était 

initialement prévu sur HANA Express (version simplifiée de SAP HANA), il a finalement été 

réalisé sur SAP HANA, d’une part en raison du manque d’espace sur mon ordinateur (un 

minimum de 32 GB RAM est requis) et d’autre part en raison de la possibilité d’utiliser un 

système test existant et disponible auprès du Centre de Compétences SAP ACC Switzerland. 

La première semaine de travail s’est focalisée sur la rédaction du cahier des charges, 

l’établissement d’un premier plan provisoire, ainsi que sur la fixation d’un rendez-vous avec le 

responsable du travail. Les semaines de travail ont ensuite été réparties de la manière 

suivante, tenant compte du fait que les cours et les examens se sont terminés en 8ème 

semaine : 

 Environ quatre semaines pour les travaux de recherche et la rédaction de la partie 

théorique ; 

 Environ six semaines pour mettre en place les prototypes et poursuivre les 

recherches afin de bien comprendre le fonctionnement et l’implémentation du CDS 

et rédiger la partie pratique ; 

 Deux semaines pour la finalisation des prototypes et des documents, ainsi que pour 

la relecture et les corrections finales. 
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Annexe VI : Cahier des charges 

 

Cahier des charges 
 

Caractéristiques des tâches à effectuer pour le travail de Bachelor : 

 Concept et explication du CDS ; 

 Lister et expliquer les différentes fonctionnalités disponibles ; 

 Explication de l’ABAP CDS, HANA CDS ; 

 Différence entre ABAP CDS et HANA CDS ; 

 Avantages et inconvénients par rapport à l’ABAP Dictionary ; 

 Création d’un prototype ABAP CDS ;  

 Création d’un prototype HANA CDS (+ Installation SAP HANA Express) ; 

 Prise de décision : Est-ce mieux de passer à SAP CDS ou de rester à ABAP 

Dictionary ?;  

 Quelles sont les étapes futures, l’évolution ? 
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Annexe VII : Détails des heures 

Le détail des heures consacrées au travail de Bachelor est exposé ci-dessous. Le CD se trouvant sur la dernière page de ce rapport permet 

de visualiser à travers les différentes semaines le détail des tâches réalisées et les heures effectuées chaque jour. 

 

Figure 90 : Annexe VII - Détails des heures90 

 

 

                                                      
 
90 Source : Donnée de l’auteur 
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Annexe VIII : Rapport hebdomadaire 

Un exemple de rapport hebdomadaire est illustré ci-dessous. La totalité des rapports est 

disponible sur le CD se trouvant sur la dernière page de ce rapport. 

 

Figure 91 : Annexe VIII - Rapport hebdomadaire91 

  

                                                      
 
91 Source : Donnée de l’auteur 

http://www.rapport-gratuit.com/
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